Performing a DFA analysis

In this tutorial, we analyze a small assembly in the DFA Product Simplification software and then we redesign that assembly by combining or eliminating parts to simplify the product structure. The original and redesigned products are then compared using the results features that are incorporated into the DFA software.

To begin, open the analysis file for the Pneumatic control that has been installed with your DFA software. Select Open from the File menu, browse to DFMA\data\samples, and double click the Pneumatic control.dfax analysis file.

The product analyzed in this tutorial is the small pneumatic control pictured below.

Each of the items pictured will be added to the Structure chart on the left side of the main program window. The DFA questions will then be answered for each item so that the program can estimate the assembly process time and cost.

Setting up the DFA software

In order for your computer’s display to match this tutorial, be sure that your software is set up to do a DFA analysis in English units with dimensions in inches. Click the Analysis menu and be sure that DFA is selected.

Select Set units... from the Analysis menu and be sure the Units tab on your Options dialog appears as shown below.

Click OK to close the Options dialog and return to the DFA main window.

Click the Insert menu and be sure that Assembly order is selected.
DFA Product Simplification

Beginning the analysis

With the *Original design - step 1* analysis tab selected, click twice the *Untitled* main assembly entry at the top of the Structure Chart and name it *Pneumatic control*.

Enter the following information into the DFA Questions panel.

Part number: 1234

Manufacturer Name: *Pneumatic Industries*

Manufacturer Location: *Wakefield, RI*

Life volume: 1000

Accept the default values for the Labor rate (40$/hr) and the Overall plant efficiency (85%).

Enter into the Envelope dimensions group box, the dimensions of the smallest rectangular prism that encloses the fully assembled pneumatic control, 1.1, 2.5, and 3 inches. Dimensions can be entered in any order. Since the assembly is considered small, the program will assume that all parts are within easy reach of the assembly worker.

Adding the Plastic base

Add the first part to the structure chart. Choose *Part* from the Insert menu or click the button on the toolbar. Name the part *Plastic base*.

Click the *Part number field* on the DFA Questions panel and enter 1234-1.

Accept the default values for the repeat count (1) and the item weight classification (Less than 5 lb (2.27 kg)).

Accept the default rectangular shape selection for the Plastic base, and enter dimensions of 1.1 in., 2.5 in., and 3 in. Dimensions can be entered in any order.

The Plastic base has a function other than fastening or securing other items and it has a function other than connecting other items. For this reason, accept the default value of *Item has other function* within the *Item function* group box.

Because the Plastic base is the first part added to the product, there are no other items that can be used to evaluate against for the minimum part criteria. For this reason, choose *Base part (usually only the first)* in the *Minimum part criteria* group box.

Imagine rotating the Plastic base pictured below about each of its three axes, one at a time. For each axis, a complete 360 deg. rotation is required before the Plastic base repeats its original orientation. This means that the part does not repeat its orientation about any of its axes with a 180 deg. or less rotation. For this reason, accept the default *No axes* button in the *Symmetry* group box.

The Plastic base will be acquired by the assembly worker and placed into a simple fixture so that it is ready to receive the remaining parts.

Grasping and manipulating the Plastic base can be done with one hand and no tools and it presents no other handling difficulties. Accept the default of *One hand without grasping* tool in the *Handling requirements* group box and leave unchecked all of the difficulties in the *Handling difficulties* group box.

Assuming that the Plastic base will be placed into its fixture and remain unsecured, accept the default *Added but not secured* button in the *Securing process* group box. Also, assuming that the fixture is well designed and there are no problems during insertion of the part, leave unchecked all of the difficulties in the *Insertion difficulties* group box.
Based on the answers provided to the DFA questions, the program has estimated that the time to acquire, handle, and insert the Plastic base is 3.54 s. The process time and process cost results are shown in the status bar at the bottom of the program window.

**Adding the Piston subassembly**

Add the piston subassembly to the Structure chart. Choose *Unanalyzed Subassembly* from the Insert menu or click the button on the toolbar. Name the subassembly **Piston sub**.

Click the Part number field on the DFA Questions panel and enter **1234-2**.

Accept the default values for the repeat count (1) and the item weight classification (Less than 5 lb (2.27 kg)).

In the *Envelope dimensions* group box, click the cylinder button and accept **1** in. for the diameter and **1** in. for the length of the Piston sub.

The Piston sub has a function other than fastening or securing other items and it has a function other than connecting other items. Accept the default value of *Item has other function* within the *Item function* group box.

The Piston sub must move relative to the Plastic base. The required movement is substantial and could not be accommodated with some integral elastic elements between the Plastic base and the Piston sub. For this reason, click **Moves relative to all other items** in the *Minimum part criteria* group box. This means that the Piston sub is a theoretically necessary item and cannot be designed out of the product by incorporating features into the plastic base to serve the function of the Piston sub.

Imagine rotating the Piston sub pictured below about each of its three axes, one at a time. About the principal axis, the part requires 0 deg. of rotation before it repeats its orientation. The remaining two axes both require a complete 360 deg. rotation before the Piston sub repeats its original orientation. This means that the Piston sub has 180 deg. or less symmetry about one of its axes. Click the **One axis** button in the *Symmetry* group box.

Grasping and manipulating the Piston sub can be done with one hand and no tools, it presents no handling difficulties, and it will not be secured immediately upon insertion into the base. Accept all of the default values in the *Handling requirements*, *Handling difficulties*, and *Securing process* group boxes.

Insertion of the Piston sub into the Plastic base can cause problems because there are no chamfers or other features that would make the two items self aligning. The Piston sub must also be released by the assembly worker before its spindle can be located in the small hole in the base. This can lead to the hang-up condition shown here.

For these reasons, click **Not self-locating** and **Resistance or hang up** in the *Insertion difficulties* group box.

The program has estimated the time to acquire, handle, and insert the Piston sub into the Plastic base is 5.22 s as shown in the status bar.
DFA Product Simplification

DFA questions for the Piston stop
Click the analysis tab named Original design - step 2 at the top of the program window. This analysis is identical to the analysis completed so far in the present tutorial except that the Piston stop, Steel spring, Steel cover and the Screws have already been added to the structure chart to save time.

Click the Piston stop and note that the part number and the envelope dimensions have already been entered.

Accept the default values for the repeat count (1) and the Item weight classification (Less than 5 lb (2.27 kg)).

The Piston stop has a function other than fastening or securing other items and it has a function other than connecting other items. Accept the default value of Item has other function within the Item function group box.

The Piston stop must obstruct the bore in the plastic base in order to stop the Piston sub from over compressing the Steel spring. It is not possible to incorporate features into the Plastic base or the Piston sub that would provide this obstruction in the bore without preventing assembly of the Piston sub. For this reason, click Separate to allow assembly in the Minimum part criteria group box.

Imagine rotating the Piston stop pictured below about each of its three axes, one at a time. About the principal axis, the part requires 0 deg. of rotation before it repeats its orientation. The remaining two axes both require a complete 360 deg. rotation before the Piston stop repeats its orientation. Click the One axis button in the Symmetry group box.

The Piston stop can be grasped with one hand and requires no grasping tools, it presents no additional handling difficulties, it is not secured immediately upon insertion, and it presents no insertion difficulties when it is inserted into the Plastic base. For these reasons, all of the remaining default values apply and no further responses are required for this item. The software has estimated 3.22 s to acquire and insert the Piston stop.

DFA questions for the Steel spring
Click the Steel spring on the structure chart.

The part number and the envelope dimensions have already been entered and the default values for the repeat count (1) and Item weight classification (Less than 5 lb (2.27 kg) are appropriate for the steel spring.

The Steel spring has a function other than fastening or securing other items and it has a function other than connecting other items. Accept the default value of Item has other function within the Item function group box.

The Steel spring does not have to be made from a different material than every other item assembled in the product so far. At least theoretically, the material from which the Piston sub is made could be changed to the same spring steel used in the spring. The end of the spring that is in contact with the top of the Piston sub does not move relative to the Piston sub and combining the Steel spring with the Piston sub would not prevent the assembly of other items in the product. This means that the spring is a candidate for elimination from the product because, at least theoretically, a spring feature could be integrated into the top of the Piston sub to serve the function of the spring. Accept the default value of No fundamental reason exists within the Minimum part criteria group box. In the Notes group box enter Combine with Piston sub?

About the principal axis, the Steel spring pictured below requires 0 deg. of rotation before it repeats its orientation. The remaining two axes of the spring have 180 deg. symmetry. Click the Two axes button in the Symmetry group box.
The Steel spring will severely tangle when in bulk and requires two hands to manipulate and separate. For this reason, click Two hands - severe nest or tangle.

The Steel spring presents no additional handling difficulties, it is not secured immediately upon insertion, and it presents no insertion difficulties when it is placed into the Plastic base. For these reasons, all of the remaining default values apply and no further responses are required for this item. The software has estimated 5.6 s to acquire and insert the Steel spring.

**DFA questions for the Steel cover**

Click the Steel cover on the structure chart.

The part number and the envelope dimensions have already been entered and the default values for the repeat count (1) and Item weight classification (Less than 5 lb (2.27 kg) are appropriate.

The Steel cover has a function other than fastening or securing other items and it has a function other than connecting other items. Accept the default value of Item has other function within the Item function group box.

The Steel cover does not have to be made from a different material than every other item assembled in the product so far. In particular, the Steel cover could be made from the same plastic as the Piston stop. The Steel cover does not move relative to the piston stop and combining the Steel cover with the Piston stop would not prevent the assembly of other items. This indicates that the Steel cover is another candidate for elimination because a feature could be incorporated into the Piston stop to serve the function of the cover. Accept the default value of No fundamental reason exists within the Minimum part criteria group box. In the Notes group box enter Combine with Piston stop?

The cover pictured below will repeat its orientation if it is rotated 180 deg. about all three of its axes. Click Two axes for Symmetry.

![Steel cover image](image)

The Steel cover can be grasped with one hand and no grasping tools and it presents no additional handling difficulties. Accept the default values in the Handling requirements and Handling difficulties group boxes.

Because the spring needs to be compressed as the cover is installed, the cover needs to be held down while the screws are inserted. Click Added and held down for the Securing process.

There are no features to guide the cover into place as it is inserted on top of the Plastic base. Click Not self-locating in the Insertion difficulties group box.

The software has estimated 8.49 s to acquire and insert the Steel cover.

**DFA questions for the Screws**

Click the Screws on the structure chart and note that the part number has already been entered.

Enter a value of 2 for the Repeat count.

Accept the default values for the Item weight classification (Less than 5 lb (2.27 kg) and note that the envelope dimensions for a screw have already been entered.

The Screws serve no function except to fasten the cover in place. Click Fasten or secure other items in the Item function group box. Fasteners do not meet any of the three minimum part criteria and are automatically candidates for elimination from the product structure. This is because, theoretically, integral fastening elements could be incorporated into the secured items to make them self securing and eliminate the separate fasteners. In the Notes group box enter Eliminate and make the cover self-fastening?

A screw requires 0 deg. of rotation about its principal axis before it repeats its orientation. The remaining two axes both require 360 deg. of rotation before the orientation is repeated. Click the One axis button in the Symmetry group box.

The screws can be grasped with one hand and require no grasping tools and they present no additional handling difficulties. Accept the default values in the Handling requirements and Handling difficulties group boxes.
Click **Threaded fastening** for the securing process.

Assuming a screwdriver will be used to tighten the screws, click **Nut/screw driver** for the **Operation characteristics**. Accept the default value for the **Number of revolutions** (5).

Because there are no pilot points on the screws, click **Not self-locating** in the **Insertion difficulties** group box.

The software has estimated 18.92 s to acquire and manually start the two screws, acquire a screwdriver and tighten the two screws, and then set aside the screwdriver.

Click the **Pneumatic control** entry on the structure chart and note in the Status bar that the software has estimated a time of 44.99 s to assemble one Pneumatic control. At the labor rate of 40$/hr and the Overall plant efficiency of 85%, the cost of that assembly labor is $0.59.

**Product Redesign**

Make a copy of the Piston analysis we’ve just completed. Right click the **Original design - Step 2** analysis tab at the top of the program window and click **Copy** from the pop-up menu. Right click on the **Original design - Step 2** analysis tab again and click **Paste** from the pop-up menu. Double click the new tab and name it **Redesign**.

Click the **Redesign** button at the top of the structure chart to display the Redesign worksheet. Three categories of redesign suggestions are shown in the **Suggestions for redesign** panel on the right side of the program window. These suggestions are listed in the order in which they should be evaluated and as the suggestions are selected, entries in the analysis are highlighted for the suggestion.

With **Candidates for elimination other than fasteners and connectors** selected on the right side of the window, the Steel spring and Steel cover are both highlighted as candidates for elimination within the product structure. These redesign suggestions should be evaluated very carefully because these are the two suggestions that are likely to result in the largest reductions in the cost of the product.

For the Steel spring, the note made during the original analysis indicates that it is theoretically possible to combine the Steel spring with the Piston subassembly. Although this is theoretically possible, combining the two items is unlikely to result in a practical part that will provide the necessary spring and piston functionality within the product. For this reason, this redesign suggestion will no longer be considered and a combined spring/piston subassembly will not be included in the redesigned product. This illustrates that not all redesign suggestions which are identified in the original analysis will result in practical redesign ideas that are carried forward into a product redesign. Even so, it is still best to identify all theoretical redesign suggestions when the original analysis is done and then abandon any that are impractical at this point in the redesign process.

For the Steel cover the note made during the original analysis indicates that it may be possible to combine the steel cover with the Piston stop. Imagine a plastic piston stop that incorporates a cover feature to secure the top of the Steel spring in place. This redesign idea is quite practical and will be carried forward into the redesigned product. On the Redesign worksheet, click twice the name of the **Piston stop** and change it to **Piston stop/cover**. Click the name of the **Steel cover** and delete it from the analysis by pressing the **Delete** key on your computer’s keyboard. Move the **Piston stop/cover** to the end of the Redesign worksheet using **Cut** and **Paste**. Click the name of the **Piston stop/cover** on the Redesign worksheet and then select **Cut** from the **Edit** menu at the top of your screen. Click the name of the **Screws** on the Redesign worksheet and select **Paste** from the **Edit** menu.

On the right side of the screen, click **Fasteners** under the Category 2 redesign suggestion label. These redesign suggestions should only be considered after exhausting all Category 1 redesign suggestions, for two reasons. First, following a Category 1 redesign suggestion will frequently remove related fasteners, connectors, and separate operations from the product making many Category 2 redesign suggestions superfluous. Second, the product improvements attained by following a Category 2 redesign suggestion tend to be smaller than those attained when a Category 1 suggestion is implemented.

The screws are highlighted as candidates for elimination within the product structure and the note made during the original analysis indicates that it may be possible to eliminate the screws by making the cover self fastening. This is a practical redesign idea that will be incorporated in the redesigned product by adding to the Piston stop/cover, features that snap into an annular groove within the bore in the plastic base. On the Redesign worksheet, click the name of the **Screws** and delete the items from the analysis by pressing the **Delete** key on your computer’s keyboard. Click the name of the **Piston stop/cover** on the Redesign worksheet and then click the **Questions** button above the structure chart. Click the **Snap/Push fitting** button to change the securing process for the Piston stop/cover to snap fitting. Click the **Redesign** button to return to the Redesign worksheet.

There are no connectors or separate operations in the analysis of the Pneumatic control, so click the Category 3 redesign suggestion **Handling or insertion difficulties**. These redesign suggestions should be considered last because they normally generate the smallest of improvements in the product. The Piston sub and the Steel spring are both highlighted within the

6 / Performing an Analysis
product structure.

The Piston sub is highlighted because, during insertion, it is difficult to align and presents resistance due to the hang up condition identified in the original analysis. One solution to this problem is to add a small projection to the top of the piston subassembly as shown below. This projection would be used by the assembly worker as a handle to allow control of the piston subassembly during insertion of the piston rod through the hole in the plastic base.

![Piston subassembly with projection](image1.png)

This is a practical idea to eliminate the piston subassembly’s insertion difficulties and will be incorporated into the redesigned product. On the Redesign worksheet, click the name of the Piston sub and then click the Questions button above the Structure chart. Uncheck the Not self locating checkbox and also uncheck the Resistance or hang up checkbox. Click the Redesign button to return to the Redesign worksheet.

The Steel spring is highlighted on the Redesign worksheet because it presents a severe tangling situation that adds 2.67 s. of process time during handling prior to insertion. With the small number of Pneumatic controls produced, it is unlikely to be cost effective to custom make a spring that does not tangle in order to save 2.67 s of process time. For that reason, this redesign suggestion will be abandoned and the redesigned product will use the same off-the-shelf spring that is used in the original design.

When all of the practical redesign ideas are incorporated into a new design of the pneumatic control, the design pictured below is realized.

![Redesigned pneumatic control](image2.png)

Click the Questions button above the Structure chart and then click the Pneumatic control entry on the Structure chart. Note in the Status bar that the software has estimated a time of 16.34 s to assemble a redesigned Pneumatic control. At the labor rate of 40$/hr and the Overall plant efficiency of 85%, the cost of that assembly labor is $0.21.

In order to make comparisons using the results features that are built into the DFA software, the Original design- completed and Redesign - completed analysis tabs will be used. These analyses are identical to the analyses created in the present tutorial except that they also include part manufacturing cost estimates for all parts within the original and redesigned Pneumatic controls.

Click the Original design- completed analysis tab to select that analysis. Click the Results menu at the top of your screen and then click Analysis totals - DFMA -> Include Tool Cost. When the Select analyses dialog appears, select the Original design -
DFA Product Simplification

Note in the first table on the report that the Assembly process cost has been reduced from $0.59 down to $0.21, for a savings of $0.38 in assembly labor. Also note that applying DFA to the pneumatic control has reduced its total cost from $4.25 to $3.65, for a total cost reduction of $0.60 per product. As indicated in the third table on the report, the production life cost has been reduced from $42,526 to $36,531 for a total savings of just under $6,000 over the production life of the pneumatic control.

The pneumatic control is a fairly simple product that is produced in somewhat low volumes. Although the cost of this pneumatic control was reduced just over 14 percent by applying DFA, experience has shown that much larger opportunities for savings exist when DFA is applied to more complex mechanical and electro-mechanical assemblies or to assemblies that are produced in higher volumes.